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About This Guide 

Welcome to the Spelman College Faculty Technology 
Guide. This guide is published by the Media & Information 
Technology Division (MIT) to provide a list of available and 
support technology services to the Spelman Community, 
as well as helpful technology tools. 

 

The information in this technology guide is current as of 
August 2017. This resource was created to support the 
technology activities and needs of our faculty 
community. As this is not a final publication, we invite 
and encourage your suggestions. To submit your 
feedback, email us at: mitservice@spelman.edu.  

Media & Information Technology Division Mission 
 

To provide a reliable and secure data network that enables convenient access 
to information on campus and beyond. 

To provide a standardized technological 
environment which is consistent yet 
accommodates the diversity of needs. 
To provide exemplary customer service 
through a knowledgeable staff. 

To provide reliable and comprehensive 
information systems that makes pertinent data 
available in a timely and consistent manner. 
To provide documentation, training, and 
support for faculty, staff and students to foster their effective and efficient 
utilization of information resources. 

 
To learn more about the Media & Information Technology Division and 
Campus Technology, visit the MIT Service Catalog on the MySpelman portal. 
Log on to the MySpelman with your network username and password. 

 
MIT Support Priority Levels & Response Time Goals 
 

Priority 

Level 

De fini ti on Response Time Resolution Time 

1 • Problem affecting a building or the entire 
campus significantly 

• Problem affecting a class, meeting or 
demonstration in progress 

• Problem affecting ability to perform any work 
activities 

5-10 minutes 1 business day 

2 •  Problem affecting a small number of people 

significantly 

1 Business day 3 business day s 

3 • Problem affecting a small number of people, 
but work can still be performed 

2 business day s 5 business day s 

 
 
 
 

 
 Acco unts  

 
MIT supports the following systems: 

My.S pelman Portal- access to Enterprise Apps & Campus Resources 

Network - SC network and desktop computers 

 IBM Notes College email -client desktop email & Webmail  

Banner Self Services - Academic Information System   
Spel.eLearn - Course Management System 
SpEl.Folio - ePortfolio Initiative  
Techsmith Relay 
Microsoft Office 365 
Lynda.com 

mailto:mitservice@spelman.edu.
http://mit.spelman.edu/itcatalog/
http://my.spelman.edu/
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Information Technology Services 
 
Service Desk 

 

Contact the Service Desk to report any technology-related issues. The Service Desk is staffed with knowledgeable support 
technicians and students dedicated to providing: 

Telephone support Walk-in support 
Hardware and software installations  Internet and network connectivity support 

Lab management support Technology purchases 
 
 
 
 
 
 
 

 
Computer Equipment Loan Procedures 

 

Requests f or laptops and other computer loaner equipment 
should be directed to the Service Desk (ext. 5400, option 1, 
then press #1 or email to mitservice@spelman.edu).  Laptops 
and other loaner equipment must be used for Spelman 
College activities only and should not be used for personal 
use. 

 

To learn more about the Computer Equipment Loan Procedures, 

please visit MIT Service Catalog on the MySpelman portal. 

Departmental Equipment Purchasing Procedures 
 

Contact the Service Desk (ext. 5400, option 1, then press #1 
or send email to  mitservice@sp elman.ed u) for information 
regarding estimates or quotes for purchasing departmental 
equipment. You may also submit a purchase inquiry request.  
You may need to provide a detailed description of your 
system requirements and software needs. 

  

 

 
 

Student Technology Assistance Center 
 

The Student Technology Assistance Center (STAC) is a student 
staffed technology center 
that provides technology 
assistance to students.  STAC 
are trained student 
technologists managed and 
trained by senior MIT staff 
members. 

 
STAC provides student training and support f or the following 
software and services: 

Residential network connectivity  
Laptop Loaners 

Adobe Photoshop 
Microsoft Office 365 
Webmail 
SpEl.Folio 
Spel.eLearn 
iMovie 
Training Workshops 

Service Desk Quick Contact Information 

Service Desk Support Services 
Location: Academic Computing Center Building (ACC), Room 201 

Hours of Operation: 

Calls: Monday-Friday from 8:30 am to 5:30 pm  
After-hours Phone Support: Monday thru Friday  

5:30 pm to 7:00 pm 
24 hour coverage 7 days/week (*after 7:00 pm please leave 

a message) 

On-C ampus Extension: 5400 (Option 1, then press #2) 

Off-Campus: (404) 270-5400 (Option 1, then press #2) 

Email: mitservice@spel man.edu 

 
 
Student Technology Assistance Center (STAC) 
Location: Lower Manley 

Phone: 404-270-5324 

Hours of Operation: 

Monday to Thursday from 10:00 am to 8:00 pm 
Friday from 10:00 am to 4:00 pm 
Saturday and Sunday from 1:00 pm to 4:00 pm 
Hours of operation are subject to change based on demand 

 
Poster Printing Services 
Contact: 404-270-5709 

mailto:mitservice@spelman.edu).
http://mit.spelman.edu/itcatalog/
http://www.spelman.edu/~itc/el.html
http://www.spelman.edu/~itc/el.html
mailto:help@spelman.edu
mailto:mitservice@spelman.edu
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Request additional software installations for electronic classrooms 

and computer labs by completing the Electronic Classrooms 

Resources Form located on the IBM  Notes Dashboard on the 

General tab. You can also complete your request online by visiting 

MIT Requests in the MIT Service Catalog. 

Information Technology Services 
 

Computer Lab Services 
 

Computer Lab Services provides hardware and software support 
for the electronic classrooms, computer laboratories, and 
manages Spelman’s open access labs. 

 
Faculty Assistance: 

 
Hardware support for electronic classrooms and computer 
laboratories 

 

Software installations for electronic classrooms and 
computer laboratories 

 

Computer labs providing open 
access privileges to students are 
Science Center, Rm. 230 (24 hour 
access), Tapley, Rm. 226, Giles, 
Rm. 316, and the Writing Center, 
Cosby Rm. 332. Individual hours 
of operation are posted in each 
lab. 

 

Spelman College electronic classrooms and computer 
laboratories include the following hardware: 

 

IBM compatible workstations 
 

Mac workstations 
 

Sun Solaris workstations 
 

Standardized software (i.e. Microsoft Office 2016, McAfee anti- 
virus, Internet Explorer, and Deep Freeze) is installed on all 
computers in electronic classrooms and computer labs campus 
wide. Additional software is installed at the request of 
departments overseeing departmental labs and is specific to the 
department's discipline. A complete list of electronic classrooms, 
computer labs, their locations, and standard applications can be 
found by visiting:  http://princess.spelman.edu/ecr.nsf 

 
 
 

 
Requesting Classroom Software 

 
 
 

 
 

 
 

 
Computer Labs & IBM Notes Quick Contact 

Information: 
 

 
Computer Lab Services 
Location: Science Center, Room 229 

Phone: 4 04-270-5400 (Option 1, then press #2) 

Email: mitservice@spelman.edu 
Hours of Operation: Monday- Friday from 9:00 am – 5:00 pm 

On-Campus Extension: 5400 (Option 1, then press #2) 
Off-Campus: (404) 270-5400 (Option 1, then press #2) 
Email: mitservice@spelman.edu 
 
 
IBM Notes & Web Mail Services 

Spelman College Service Desk 
Phone: 4 04-270-5400 (Option 1, then press #1) 
Email: mitservice@spelman.edu 
 
 
 
 
 

https://mit.spelman.edu/itcatalog/?q=content/requests
http://princess.spelman.edu/ecr.nsf
mailto:mitservice@spelman.edu
mailto:mitservice@spelman.edu
mailto:mitservice@spelman.edu
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Educational Technology  
 

Instructional Technology & Design Services 
 

The Instructional Technology supports the selection, evaluation, 
implementation, and delivery of learning materials/systems to 
make teaching and learning more efficient for faculty, staff and 
students. 

 
Supports: 

 

Adobe Connect 
Course Design 
Lynda.com 
Microsoft Office 365 
Respondus Quiz Maker, Lockdown Browser and Monitor 

Spel.eLearn(Moodle) support 
SpEl.Folio support 
Techsmith Relay  
Departmental Workshops 
Faculty Training 
Multimedia Tools (Web 2.0) assistance 

 
Classroom Technology: 

 

Instructional Technology provides training on how to use 
classroom technology including: 

Clickers 
Lecture Capture Videos 
SMART Board and Sympodium 
Document Camera 
Vision Classroom Management Software 
Videoconferencing 
Web conferencing 

 
Technology Training: 

 
Training is offered in three formats: instructor-led workshops, 
Webinars, and Lynda.com self-paced training modules. 

 
Instructor-led workshops. 

 
Webinars. F a c i l i t a t e d  online workshops, only requiring 
access to a telephone and a computer with access to the 
Internet. 

 
Lynda.com Self-paced Training modules. Online tutorials are 
available to faculty, staff, and student 24 hours a day, 7 days a 
week. 
 

There are over 100 training modules, including: 
Microsoft Office 365 

Design and Digital Media editing (Adobe Acrobat) 

Project Management 
 

For current workshop listings, please visit: 

http://princess.spelman.edu/SCTRAIning.nsf 
 
 

 mySpelman Portal |my.spelman.edu 

 

 
 

 
 

Classroom/Lab Software: 
 
 Respondus Lock Down Browser and Monitor 
      
 
 
 
 
 
 
 
                   
 


Vision Classroom Management Software 
 

 
 
The mySpelman Portal allows faculty, staff and 
students the ability to use a single username and 
password to access campus services and applications.  
A few of the portal services are single sign-on access 
to: 


 Banner, SpelFolio, and Lynda 
Library Services 
Discussion Forums 
Campus News 
Lost and Found 
Login on with your Network Username & Password 
 

 

When students use LockDown Browser they are 

unable to print, copy, go to another URL, or access 

other applications. When an assessment is started, 

students are locked into it until they submit it for 

grading. Monitor is a companion product for 

LockDown Browser that enables institutions to 

protect the integrity of non-proctored, online exams. 

Vision lets you make the most of your time when 

integrating technology in the classroom. It gives you 

the tools you need to control sources of distraction, 

monitor student computers, get started without lost 

transition time and notice as soon as someone needs 

your help. 

 

http://princess.spelman.edu/SCTRAIning.nsf
http://my.spelman.edu/
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Technology  (cont.) 
 

 

 
 
 
Learning Spaces: 

 
Spelman College has several learning environments that 
facilitate the integration of technology in teaching.  

 
Active Learning Classrooms 

SCI CTR - Tapley 133,  SCI 238,  SCI 337 

Cosby 217 
 
E-Labs/ Electronic Labs 

Student computer workstations 

Instructor PC 

Digital Projector 
Projector 

Screen/Whiteboard/ 
Sympodium 

 

 
Technology Enhanced Classrooms 

Instructor PC 

Digital Projector 

Projector Screen/Whiteboard 
 
 

 
Science Labs (Hybrid) 

Lecture-style seating 

Digital Projector 

Projector Screen 

Whiteboard 
 
 
 
Distance Learning Classroom 

Sci Ctr 232, Cosby LL27, Fine Arts 129 

Instructor PC 
Digital Projector 

Projector Screen/Whiteboard 

Videoconferencing equipment 
Document Cameras 
Audio conferencing capabilities 

 
 
Keys to the Instructor workstation cabinets can be pic ked up in the 
A/V Technology Services office s, Cosby LL1. 

 
VoiceThread: 

 

            
 

 
 
 
 
 

VoiceThread is a cloud-based 

application that allows 

professors and students to 

upload, share and discuss 

documents, presentations, 

images, audio files and videos. 

VoiceThread is asynchronous: 

That means that students can 

view and work on VoiceThread 

lessons at any time! 
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SpeleLearn (Moodle): 
 

Spel.eLearn (Moodle) is the course management system used at 
Spelman College to support web enriched courses.  
 
Faculty use Spel.eLearn to: 

Organize and deliver course materials 

Deliver tests online 

Administer self-tests and surveys 

Post lecture notes 

Deliver assignments and presentations 

Post class events, and grades 
 

SpEl.Folio: 
 

The Spelman College Electronic Portfolio Project (SpEl.Folio) 

For the institution, 

Records in SpEl.Folio allow the College to record the way 
higher education goals have been met by the evaluation 
of real student work performed within the College 
curriculum. 

Allows the College to view its successes and challenges 
and to report to accreditation authorities. 

For the faculty, who teach with the ePortfolio, 

Furnishes a record of achievement of the learning 
objectives of the institution, especially in general education. 

Allows for a consistent assessment of performance 
through established standards (expressed in rubrics). 

Helps faculty review the College programs and improve 
them where needed. 
Serves as a reference for progress through the Spelman 
curriculum. 

Helps to develop a vision of changes over time, and how 
the many experiences at Spelman fit together to shape 
perspectives and analytical skills. 

Allows the integration of images, videos, and other 
multimedia with written text. 

 

Web Conferencing: 
 

Adobe Connect & Bluejeans provide excellent platforms for 
enhancing blended pedagogies, collaboration, and online 
learning. The applications provide flexibility in delivering rich 
content including streaming audio, video, and slide show 
presentations.   

 

Contact scitds@spelma n.edu for more information  

about the Ed Tech apps and view our EDTech Toolkit. 
 

Techsmith Relay: 
 

Whether you want to flip your classroom, make a quick review 
video, or record your entire lesson, you can use TechSmith 
Camtasia Relay! Camtasia Relay gives anyone the ability to record 
and share videos securely from anywhere. It includes an easy-to-
use desktop and mobile recorder, built-in quizzing and analytics, 
plus hosting to manage videos and images effectively. Faculty and 
staff who already have the Camtasia application now have a place 
to store and manage their class videos. Camtasia Relay is a great 
addition to the flipped classroom and departmental training 

 
Respondus – Quiz Maker: 
 
Respondus is an exam creation software tool that can integrate 
exams into Moodle making test creation and online exam delivery 
seamless.  
 
 

Instructional Technology and Design Services 
Quick Contact Information: 

 
Appointments are available for individual consultations 
and multimedia project assistance for faculty. 

 

 
Sandra Butler 
Associate Vice President, Educational Technology Services 
Media & Information Technology 
404.270.5447 

 
Blanche Bryant 
Manager, Instructional Technology & Design Services 
404-270-5389 

 
 

Montez Bell 
Instructional Technologist 
404.270.5391 
 

Constance Dixon 

Instructional Technologist 

404-270-5818 
 
 
 
Instructi onal Technology &  D e s i g n  S e r v i c e s  ( I T D S )  
Spelman College Service Desk 
Phone: 4 04-270-5400 (Option 1, then press #2) 
Email: scitds@spelma n.edu 
Hours of Operation: Monday-Friday from 9:00 am – 5:00 pm 
Instructional Technology On-line Information: Please see the 

ITDS page under the Media and Information Technology tab on the   

Portal 

 
For Educational Technology helpful information, see 

Appendix A, Helpful Tips: Educational Technology, page 13 

mailto:itc@spelman.edu
http://mit.spelman.edu/ets/edtechnology-toolkit/
mailto:itc@spelman.edu
http://www.spelman.edu/~vhd
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A/V Technology Services 
 

A/V Technology Services provides audio/visual (A/V) support for academic activities and all other campus events. 

 
Services: 

 
Events: 

A/V and multimedia equipment support services 

Videotape events 

Support and equipment for events 

 
Classrooms: 

Classroom and lab A/V equipment support 

Faculty, staff and students A/V equipment support 

 
Spelman ID Car ds: 

ID cards for faculty, staff and students 

Replacement ID cards 

 
Photography: 

Events and programs photographing 

Faculty, staff and students headshots 

Specialty photographic projects 

Passport Photos (fee assessed service): 

Photos provided for faculty, staff and students 

 
Equipment Consultation: 

Consultation for purchasing new A/V equipment or specialty 
equipment 

 
Video Production Services: 

Video recording of programs 

Video editing (major events and special programs) 

Editing 
Use of studio 

Small duplication projects (VHS, DVD, CD) 

 

 

ll services, with the exception of ID cards and passport photos, require a service and/or equipment request. 
 
 

Audio/Visual Equipment Loan Policy: 
 

Audio/visual loaner equipment is available for academic or college use by current Spelman 
College faculty, staff, and students (advisors must submit requests and pick up for students). 

 
All audio/visual loaner equipment must be returned to the Educational Media Services 
location or a previously designated person or location within one hour of the agreed return 
time. 

 
Any person who checks out the A/V equipment assumes financial responsibility for any 
damages or missing parts. 

 
Educational Media Services does not provide blank media (DVDs, CDs, VHS tapes, etc .) for any 
of the audio/visual equipment. 

 
The failure to adhere to the return policy impacts other users and may result in the revocation of borrowing privileges for the academic year. 

 
 

A/V Technology Services Quick Contact Information: 
 

Location: Cosby LL1 
Spelman College Service Desk 
Phone: 4 04-270-5400 (Option 1, then press #3) 
Emergency Classroom Support: 404-270-5400 (Option #8) 
Email: mitservice@spelman.edu 

Hours of Operation: Monday- Friday from 8:30 am – 5:30 pm 

 
See Appendix A, Helpful Tips: Educational Technology, 
Page 13 for additional information. 

mailto:mitservice@spelman.edu
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BANNER SERVICES 
 

Banner, the College's Academic Information System software application, integrates student, financial, human resources, and 
financial aid data. The Banner application was developed specifically for higher education institutions by Sungard Higher Education 
(SCT). Banner processes, stores, retrieves and reports information from one integrated set of data. 

 
One of the primary distinguishing features of the Banner system is its database structure which allows for online real time access 
through the web. Faculty can check course enrollments, student information, submit grades, and much more all via the web. 

 
Services: 

Supports Banner system 
Supports system maintenance and upgrades 
Assists with reporting 

 
Please report your Banner problems to the Service Desk at 404-270-5400 (or by email at mitservice@spelman.edu). 

 

For more information on Banner, see Appendix A, Helpful Tips: Banner 

(page 14) and the Banner Guide. 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Network & IT Operations 

 

Accessing Banner 
 

 

Logon to Banner with your SC Identification 
Number ( SCID, your 900#) and your 6 digit 
Personal Identification Number (PIN). Your PIN 
is usually your birthday (MMDDYY).  
 
If you are unable to login, contact the Service 

Desk (ext. 5400, option 1, then press #1 or send 

email to mitservice@spelman.edu). 

Banner  Services 

mailto:mitservice@spelman.edu
http://www.spelman.edu/~itc/banner.html
mailto:mitservice@spelman.edu).
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Network & IT Operations 
 

 
 

 

 

Network & Operations Services supports the College's network infrastructure and network access for faculty, staff and students. 

 
Network Services: 

 

Develops, upgrades and maintains the campus data, video, and voice connectivity 
for the Spelman College network infrastructure 

Configures, deploys, and manages the entire campus network infrastructure 

Manages voice and data network 
Supports the campus CIS instructional systems, and Banner database services 
Implements and monitors network security, and virus protection policies 

 
Wireless Services: 

 

Manages wireless access 

Wireless access is available in all administrative buildings (full outdoor wireless connectivity) 

 
IBM Notes Services 

 

IBM Notes is the official campus communication system for faculty and staff.  Google email is the campus  
communication system for students.  Both applications are supported by the IBM Notes Services team. 
 

Services: 

Supports IBM Notes desktop client email & WebMail (College email for faculty/staff) 
Supports Gmail (students) 
Manages IBM Lotus application servers 
Manages Android, Apple (iPad/iPhone), Black Enterprise server 
 

 

 
Please report your System and Network problems to Service Desk at 404-270-5400 ( or by email at mitservice@spelman.edu) 

 

 

Accessing the Spelman Wireless Network 
 

To login to Spelman’s Wireless Network: 

1.  Connect to SpelFS or Spelmanite from your computer's wireless interface. 
2.  Launch your Internet browser 
3.  Type your Spelman Network Account username and password in the wireless authentication window. 
There may be times when the authentication screen doesn’t automatically load in your browser’s window. If you 
experience problems with connecting, contact the Service Desk (ext. 5400, option #1). 

mailto:mitservice@spelman.edu
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APPENDIX A: Helpful Information 
 

Helpful Information: Troubleshooting Tips 
 

Use the following information to maintain/protect the health of 
your computer system. If you are a heavy web user or 
document saver, it is recommended that you complete a 

monthly disk cleanup and disk defragmenter on your hard drive. 
 

 
LO G G I N G SERVIC E D ES K REQUESTS 

 

1.  Please record the issue that you are experiencing. Include the exact 
error message(s). 

2.  Please report your problem to Service Desk at 404-270-5400 ( or by 
email at mitservice@spelman.edu) and provide valid contact 
information. 

4.  Please record the ticket number supplied to you by the support 
representative. This number will be used to track your work order. 
You will also rec eive an email confirmation. 

 

 
C L EA N I N G Y O UR S YS T EM US IN G D IS K C L E A N U P 

 

1.  Click the Start button. 
2.  Click the Programs button. 

3.  Click System Tools. 
4.  Click Disk Cleanup and let this run.  This process may run 

for a few minutes. 
5.  Close the window when complete. 

 

 
DE F R A G G I N G Y O UR SYS TE M US I N G D IS K DE F R A G 

 

1.  Close all applications. 
2.  Windows 7- Click the Start button, then select All 
Programs>Accessories. Now choose System Tools>Disk Defragmenter. 
3. Windows 8- PC, laptop or tablet will defrag itself by default every 
week, thanks to the scheduled task: Optimize Drives. So if you haven't 
changed any settings, you shouldn't need to defrag.  
4. Windows 10- PC, laptop or tablet will defrag itself by default every 
week, thanks to the scheduled task: Optimize Drives. So if you haven't 
changed any settings, you shouldn't need to defrag.  

 
TU R N I N G-OF F T H E D ES KT OP C LE A N UP WI Z A R D 

 

Every 60 days the Desktop Cleanup Wizard appears and prompts you to 
clean up your desktop. Stop the Desktop Cleanup Wizard from 
appearing, if you like your desktop the way it is by: 
1.  Right click an empty space on the desktop. 
2.  Click Properties. 
3.  Click the Desktop tab. 
4.  Click the Customize Desktop button. 
5.  Unc heck the box labeled Run Desktop Cleanup Wizard. 

 
 
 
 
 
BACK I N G UP YO UR D A T A 

 

You should backup your critical data to CD or thumb drive periodically. 
A backup file can be used to restore your data if your system crashes. 
There are two types of files: 

Data files that you create (Word documents, Excel 
spreadsheets, etc.) 

    Programs that you use to create your work (Word, Excel, 

Photoshop, etc.) 
 
Organize your data so the backup procedure is quick and efficient: 

     Keep all your data together: move all the files and folders 
directories you want to backup into My Documents on your 
hard drive. 

    Make sure any new files you create are saved in there as well. 

 
You can store your backup data on personal media or the Spelman 
servers, including: 

    recordable CDs & DVDs (CD-RW or CD-R) 

external (USB 2 or Firewire) hard drives 

backup space on the Spelman servers (for more information, 
contact the Service Desk, ext. 5400, option 1, then press #1 
or send email to mitservice@spelman.edu) 

 

 
SP E E D I N G -UP YO UR COM P U T E R 

 

You can make your Windows XP ,7, 8, & 10 computer run faster by 
changing its visual effects. If you're running Windows on a system which 
is low in memory, turn off the visual effects. 
1.  Right click My Computer on the Desktop or in the Start menu. 
2.  Click Properties. In the Properties dialog box, click the Advanced 
tab. 
3.  Under the Performance section, click the Settings button. 
4.  Disable the fade or slide menus/tooltips. 
5.  Disable shadows under menus/mouse pointer. 
6.  Disable smooth-scroll list boxes. 
7.  Disable the option to use a background image for each folder. 
8.  Click OK twice. 

 

mailto:mitservice@spelman.edu)
mailto:mitservice@spelman.edu)
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Helpful Information: Email 
 

 
AR C H IV I N G EMA I L 

 

 

Archiving mail allows you to manage the size of your 
mailbox by moving email messages from the I Notes Mail 
Server to a folder on your hard drive. 

 
A R C H I V I NG E M A I L F O R IBM N O TES V E R S I O N 9.0.1 

 
Archiving for the first time 

Before you can archive messages, you must create an 
archive. Follow these steps: 

1. Open your mail, select Actions > Archive > Settings > 
Criteria, and either edit existing criteria or create new 
criteria. This criteria will tell Notes which documents 
to archive and what to do with the documents. 

2. After editing or creating, select the desired criteria 
from the list and click Enable. 

3. If you have access, click the Schedule tab to 
schedule when to run archiving. You must leave your 
computer on at the time you schedule. 

To archive now, select Actions > Archive > Archive now. 
 
Schedule archiving to run automatically 

 
Open your mail, and select Actions > Archive > Settings > 

Schedule, and schedule when to run archiving. You must 
leave your computer on at the time you schedule. 
 
Archive selected messages now 

When creating or editing archiving criteria, choose 
Selected by user for the Selection Criteria. Make sure to 
enable this criteria. 

At any time after this, select the messages you would like 

to archive, and then select Actions > Archive > Archive 
selected documents. 
 
Delete messages automatically 

 
When creating or editing archiving criteria, select Just 

clean up this application without archiving. 
 

AV O I D I N G S PAM EM A I L 

 

Never reply to any SPAM email messages. If you reply to 
a piece of unwanted e-mail, you confirm the e-mail is 
active and spammers will send more email. 

 
When you receive email which IBM Notes recognized as 
SPAM email, you will rec eive a system-generated email 
from proofpoint-pps. The email has been placed in 
quarantine and will be automatically deleted after 14 days. 
 
To manually delete SPAM email messages: 

 
1.  Open the email message. 

2.  Click View. 

 

 
 
3.  Select the message by placing a check next to the message and 
click the Delete button. 

 

 

 

 

 

 

 
How do I give someone access to manage my calendar? 

___________________________________________________ 
 
You can let specified people open your mail, calendar, to do, or 

contact entries. You can also let people send, edit (including 

adding a follow-up flag), and delete messages, create and delete 

calendar entries, and create and delete to do items for you. 

 

To give a peer access to your Inbox 

 

1. Click File > Preferences. 

Mac OS X users: Click Notes > Preferences 

2. Click Mail, and then click the Access & Delegation tab. (Notes 

Basic client users: Click More > Preferences and click the 

Access & Delegation tab). 

3. On the access to your mail & calendar page, do one of the 

following: 

a. To give a new person access, click Add, and then 

specify the person or group. 

b. To change the access already granted to a person or 

group, click a person or group in the first list. The 

second list shows what access the person or group 

already has. To modify that level of access, click 

Change Access. 

4. Select which components the person or group can access, 

and then select how much they can access. 

**Results 

Note: If you give someone access to write mail for you, the mail they 

write for you is sent under your name. If you give someone access 

only to read mail for you, then the mail they write for you is sent under 

their name.  

Note: When you give people access to your mail, they cannot read 

encrypted mail that you receive. Additionally, you cannot read 

encrypted messages they create for you unless your user ID contains 

the encryption key used to encrypt the messages. Important: 

Delegates with Reader access on your mail file can also read 

calendar entries marked Private.
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Service Issue Con t ac t 
Repl acement/repai r ceili ng lights Facil ity Mana gement Services (ext. 

5440) 

Request for tables and chai rs a nd 
other such furniture for programs 

Facil ity Mana gement Services (ext. 
5440) 

Set up for ta bles, chairs a nd other 
furniture for programs 

Facil ity Mana gement Services (ext. 
5440) 

Request for l oaner la ptops for 
outside of campus presenta ti ons 

Depa rtment/Di vision must 
facili ta te 

 

 

Helpful Information: Educational Technology 
 

 
AC C ES S I N G Spel.eLearn (Moodle) 

 

Your Spel.eLearn account is created automatically when you are hired as 
a faculty person. Courses are added to your account as courses are 
assigned to you in Banner. 

Your Spel.eLearn login information: 

 Your username: your Spelman email username 
 Your password: O n e Spelman password 

 
 

When your Bannerweb pin number is changed, your Spel.eLearn 
password also changes. 

 
To login: 

 
1. From the MySpelman Portal (my.spelman.edu), Under Campus Apps,  

click   the Moodle icon to Login 
 

 
 

C LAS S R O O M TE C H N O LO G Y S UP P O R T ED BY A/V 

Technology Services 

 

The A/V Technology Services Department is responsible for 
supporting the following audio, video and instructional technology 
equipment: 

Projectors 

Crestron touch monitors 

Smartboards 

Sympodiums 

Changing Projector Light Bulbs 

Speaker systems 

Extron panels 
 

 
 
 

SE R V IC ES NOT S U P P O R T ED BY A/V Technology 
Services 

 
SUB M I T T I N G EVENT TECH NOLOGY R E Q U ES TS 

 

Media and presentation equipment can be requested from Event 
Technology online.  Equipment and supplies are limited and are available 
on a first-come, first-served basis. 

 
An equipment request should be submitted when media equipment or 
accessories are needed for the classroom or special events. They 
include: 

    TV combo 

Nomad and laptop for use with Nomad 

    DVD player 

Cassette player 

Additional equipment available upon request 

 
Service requests should be made in advance for support, in the 
classroom or for special events, and includes support for: 

Videotaping 

    Photography 

    A/V technician 

Video duplication 

    Additional equipment available upon request 

 
To submit your A/V Technology requests online: 

1.  Click on the A/V Technology Request link on the General 
tab of the IBM Applications Dashboard. 

2.  Select the type of request needed: Equipment or Service. 
3.  Complete your request. 

4.  Click the Submit button. 
 
**Event Technology Services does not loan stand-alone laptops.  Loaner 
laptops should be retrieved from the Service Desk (ext. 5400, option 1, 
then press 
#2 or send email to mitservice@spelman.edu).** 

 
Equipment and Service Deadlines: 
1.  Equipment Requests should be submitted 24 hours or more before 
the day and time the equipment is required to confirm availability. 
2.  Service Requests should be submitted at least 7 days or more in 
advance of the date and time support is needed.  During this time, 
Educational Media will: 

Consult with customers about the details of events 

Give customer time to obtain purchase order 

Secure contract support 

Obtain necessary quotes for additional equipment if needed. 
(Purchase orders are required before approved.) 

 

When your organization or program reserves an auditorium or meeting 
room which is outfitted with audio/video equipment, you are still 
required to submit a Media Equipment/Service request to reserve the 
equipment for use. 

mailto:mitservice@spelman.edu).
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Helpful Information: Banner 
 
 

 
LO G G I N G O N T O BA N NER  S E LF-S E R V I C E 

 

1.  Launch Internet browser. 
2.  Navigate to  my.spelman.edu. 
3.  Click Banner icon. 
4.  Click Faculty. 
5.  Click Banner Web.  The Banner Web screen will appear. 
6.  You will be automatically logged in to Banner Self Service  
7. Log on manually from Registrar’s link from www.spelman.edu by  
     Clicking Spelman College Self Service Login. 

 

 
 

7.  Type your 900 User Identification Number (SCID) in the User ID box 
and your 6 digit Personal Identification Number (PIN). Your default 
PIN # is usually your birthday (MMDDYY). 

 
8.  Click Login. ( Human Resources can supply your SCID 
and PIN). 

 
9.  You may be prompted to reset your PIN. Key in your current PIN and 
then create a new 6-digit PIN. Click Login. 

 
10. Create a security question and answer, click Submit. If you forget 
your PIN, you will be requested to answer this security question. 

 
The Main Menu will appear. 

 
 

BAN N ER  PE R S O N AL I NF O R MA T I O N 

 

In the Personal Information section, you are able to: 
     Update addresses 

Update contact information or marital status 

Review name or social security number change information 

Change your PIN 

Customize your directory profile 

A C C E S S I NG T H E BA N N E R F A C U LTY & A D V I S O RS ME NU 

 

When you click on Faculty and Advisors link, the Faculty Services menu 
will appear. You are able to: 

Enter Grades and Registration Overrides 

     View Class Lists 

    Access Student Information 
 
 
To retrieve class roll information: 
1.  Choose the desired term. 
2.  Choose the year. 
3.  Click Submit. 
4.  You will return to the Main Menu. Click on CRN Selection. 
5.  You will view your course(s) for this term. Highlight the desired 
course and click submit. 
6.  You will return to the Main Menu. 
 
 
 
 
AC C ES S I N G FI N A N CE I N F O R M A T I O N F OR  B U D G E T 

MA N A G E R S 

 

You must have a Banner account to access this information. To obtain a 
Banner acc ount: 
1.  Access the IBM Notes Dashboard. 
2.  Click the Banner tab. 
3.  Click Banner Account Request. 
4.  Click Form Access. 
5.  Click Finance Requests. 
6.  Complete the Banner request form and click the Submit button. 
 
To view faculty and student information: 
1.  Login to Banner 8. 
2.  Click on the Student Menu or key the name of the form (listed 
below) in the Go To block and press the Enter key. 

http://www.spelman.edu/
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Helpful Information: Spelman Network 

 
RE Q U E S T I N G A S P E LMA N AC C O U N T 

 

To obtain an e-mail or network account, you must submit an account 
request. Spelman College employees are able to access several 
systems, including: 

    Network 

    IBM Notes Email 

Banner Services 

    Spel.eLearn 

    SpEl.Folio 
 
 

If you are a new faculty member, the Provost office will make this 
request. New employee network account requests are submitted by the 
employee’s manager (the link to the New Account Application form 
below). Once MIT receives the completed form, the account will be 
activated within 3-5 business days.  When the account has been 
created, this information will be forwarded to the employee’s manager. 

 
To request a new Spelman account, please visit: 

http://princess.spelma n.edu/accountreq.nsf. 
 

 
 
 

AC C ES S I N G T HE S P E LMA N C O L LE G E NE T W O RK IN T H E 

LA BS & ELEC T R O N IC C LA SS R O O MS 

 

 

Your network account gives you access to the computers in the 
classrooms and labs.  To login: 

1.  In the username field, type sc_main\username 
2.  Type your password. 

GU ID E L I N ES FOR C R E A T I N G  PA S S W O R DS  

 

    All Spelman systems and applications require access by entering a 
valid username and password. 

    To prevent unauthorized acc ess to our systems and protect 
institutional information, MIT has implemented a “strong 
password” policy: 

• Must be changed every 90 days (based on the date that 
you last changed your password). 

• Must be a minimum of 8 characters long. 
• Must contain a mixture of letters and at least one (1) 

number and one (1) special character (!, *, @, %, $). 
 

Must be c hanged to a new password (you c annot reset your password 
to the current password). 

 

 
 
PAS S W ORD S UG G E S T I O N S 

 

Do not use well-known names or easily accessible general 
information. 

Do not use easily accessible personal information (such as 
birthdays, family members, pet names, etc.) 

Passwords should not be based on the College’s name or 
geographic location. 

Do not write your password on sticky notes or paper and leave it in 
your work area. 

 
Do not give your password to student assistants. 

 

 
 
 
DEV IC ES NOT A L LO W ED  O N T HE S P E LMA N  N ET W O R K 

 

Wireless routers, hubs, manageable/non-manageable switches, gaming 
devices, smartTv’s, or any network devices are not allowed on the 
Spelman network, including Spelman offices, classrooms, labs, and 
general building locations. These devices can cause network 
interference and security issues.  These devices are prohibited unless 
approved and/or installed by an MIT representative. If any of these 
devices are detected, your connectivity will be disabled immediately 
from the network. 

http://princess.spelman.edu/accountreq.nsf
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APPENDIX B: Acceptable Use of Electronic Resources 
 
 
 

Spelman College values technology as a means of communicating 
information and ideas to the College community and the world. In 
keeping with the College's commitment to utilizing technology in 
teaching and learning as well as administrative processes, this policy 
provides direction in the appropriate use of all forms of electronic 
resourc es on campus. The text that follows provides information on 
what constitutes a violation of Spelman's Policy on Ac ceptable Use of 
Electronic Resourc es as well as what the procedures are for addressing 
policy violation complaints. 

 
For the purposes of this polic y, electronic resources are defined as all 
computer-related equipment, computer systems, interconnecting 
networks, facsimile machines, voicemail and other telecommunications 
facilities, as well as all information contained therein (collectively, 
"electronic resources") owned or managed by Spelman College. 

 
The use of Spelman College's electronic resources is a privilege, not a 
right, which may be suspended or revoked at any time for misuse. 
Spelman College reserves the right to limit access to its electronic 
resourc es when applicable College policies, state and/or federal laws or 
contrac tual obligations are violated. The College does not, as a rule, 
monitor the content of materials transported over the College 's network 
resourc es or posted on College-owned computers and networks, but 
reserves the right to do when there is reasonable 
grounds to believe that a violation of law or College policy has occurred. 
Spelman College provides reasonable security against intrusion and 
damage to files stored on the central computing facilities, but does not 
guarantee that its computer systems are secure. Spelman may not be 
held acc ountable for unauthorized access by other users, nor c an the 
College guarantee protection against media failure, fire, floods, etc. 

 
This policy applies to all users of computer resources owned or 
managed by Spelman College, including, but not limited to, Spelman 
faculty and visiting faculty, staff, students, external individuals or 
organizations and individuals accessing external network servic es, such 
as the Internet and Intranet, via Spelman's computing facilities. 

 

 
 

US E O F RES O U R C ES 

 

All users of Spelman College electronic resources are expected to utilize 
such resources in a responsible, ethical and legal manner consistent with 
Spelman College policies. As a user of Spelman electronic resources, you 
agree to be subjec t to the guidelines of the "Policy for Ac ceptable Use of 
Computer Resources." 

 
In the text that follows, individual Policy statements are followed by 
specific examples of activities that constitute unauthorized use of 
Spelman electronic resources. 

1. Spelman College electronic resources may not be used to damage, 
impair or in any way cause purposeful damage to Spelman College 
networks or computers or external networks or computers. 
 

For example, you may not: 
 

a. Use Spelman College electronic resources to breach security of 
any computer system. 

 

b. Share your network ID and password with any unauthorized 
person on or off campus. 

 

c. Use computer resources to send large amounts of email (e.g., 
email "spamming") to an internal or external system, except for 
acc eptable college-related activities 

 

d. Send email of any type to someone's address in an effort to 
disable their email capabilities 

 

e. Forge, alter or willfully falsify electronic mail headers, directory 
information, or other information generated and/or maintained 
by the College 

 

f. Use computer resources irresponsibly or in a manner that 
adversely affects the work of others. This includes recklessly or 
intentionally (1) damaging any system by introducing computer 
"viruses" or "worms," (2) damaging or violating information not 
belonging to you, or (3) misusing or allowing misuse of computer 
resources 

 

g. Use Spelman College resources for non-College related 
activities that unduly increase the network load (e.g., chain mail, 
network gaming and spamming) 

 

h. Use Spelman College resources for any other purpose deemed 
inappropriate or unacceptable by Spelman College 

 

2. Unauthorized access, reproduction or use of the resources of others 
is prohibited, except as allowed for educational use under the Fair Use 
Doctrine of the Copyright Act of 1976 
 

For example, you may not: 
 

a. Make unauthorized copies of copyrighted materials. You should 
assume all software, graphic images, music, and the like are 
copyrighted. Copying or downloading copyrighted materials 
without the authorization of the copyright owner is against the 
law, and may result in civil and criminal penalties, including fines 
and imprisonment 

 

b. Create or execute any computer programs intended to (1) 
obscure the true identity of the sender of electronic mail or 
elec tronic messages, except when the option of anonymous 
acc ess is explicitly authorized, (2) bypass, subvert, or otherwise 
render ineffective the security or acc ess control measures on any 
network or computer system without the permission of the 
owner, or (3) examine or collect data from the network (e.g., a 
"network sniffer" program) 
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c . Use electronic resources to gain unauthorized access to 
resources of the College or other institutions, organizations or 
individuals 

 

d. Use false or misleading information for the purpose of 
obtaining access to unauthorized resources 

 

e. Access, alter, copy, move or remove information, proprietary 
software or other data files without prior authorization 

 

f. Use electronic resources to discover another individual's 
password 

 

g. Use electronic resources to obtain personal information (e.g. 
educational records, grades, or other College files) about an 
individual without their permission unless related to legitimate 
advising, mentoring or administrative activities 

 

h. Use electronic resources to forge an academic document 
 

i. Use electronic resources to steal another's individual works or 
to misrepresent one's own work 

 

j. Use electronic communication to collude on examinations, 
papers, or any other academic work in violation of College policy 

k. Use electronic resources to falsify or fabricate research data 

l. Use electronic resources to obtain or release another 
individual's or entity's proprietary information or trade secrets 

 

m. Use Spelman electronic resources for remote activities that 
are unauthorized at the remote site 

 

n. Intercept transmitted information intended for another user 
 

3. Use of Spelman College electronic resources to interfere with or 
cause impairment to the activities of other individuals is prohibited 

For example, you may not: 
 

a. Send chain email or information about pyramid schemes 
 

b. Send large quantities of email to an individual's mailbox (e.g., 
email "spamming") which has the effect of interfering with or 
c ausing impairment to that individual's activities 

 

c . Change an individual's password in an effort to gain 
unauthorized access to their account 

 

d. Communicate or use any password, personal identification 
number, credit card number or other personal or financial 
information without the permission of its owner 

 

4. Use of Spelman College electronic resources to harass or make 
threats to specific individuals, or a class of individuals is prohibited 

For example, you may not: 
 

a. Send unwanted and repeated communication by electronic 
mail, voicemail or other form of electronic communication 

b. Use email or newsgroups to threaten, stalk or harass someone 
 

c. Post or distribute via any form of electronic communication 
"hate speech" regarding a group's race, ethnicity, religion, 
gender, or sexual orientation 

 

5. Use of Spelman electronic resources in pursuit of unauthorized 
commercial activities is prohibited 

For example, you may not: 
 

a. Use computer resources for personal commercial gain, or other 
commercial purpose without approval by the College 

 

b. Use computer resources to operate or support a non-College 
related business 

 

c. Use computer resources in a manner inconsistent with the 
College' s contractual obligations to suppliers of those resources 
or with any published College policy 

 

6. Use of Spelman electronic resources to violate city, state, federal or 
international laws, rules, regulations, rulings or orders, or to otherwise 
violate any College rules or policies is prohibited. 

For example, you may not: 
 

a. Pirate software, music and images in violation of copyright and 
trademark laws 

b. Effect or receive unauthorized electronic transfer of funds 

c. Disseminate or receive child pornography or other illegal 
material 

 

d. Use computer resources to view, effect, receive or distribute 
pornography of any kind 

 

e. Violate any laws or participate in the commission or 
furtherance of any crime or other unlawful or improper purpose 

 
 

 
RE P O R T I N G & R ES PO NS E TO V I O L A T I O N S 

 

Members of the Spelman College community should report violations 
Spelman College's Policy on Acc eptable Use of Electronic Resources to 
the Vice President for Media and Information Technology. 

 

Reports of suspected unauthorized use or misuse of Spelman electronic 
resources will be investigated pursuant to standard College procedures. 
Violation of this Policy will result in action by the appropriate College 
office or agency. Such action may include, but is not limited to: 
permanent or temporary suspension of user privileges, deletion of files, 
disconnection from the Spelman network, and referral to applicable 
student/faculty/staff disciplinary processes. All potentially illegal 
activities may be reported to local, state or federal authorities, as 
appropriate, for investigation and prosecution. 
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QUE S T I O NS R E LA T I N G TO  T H IS P O LI C Y 

 

This policy supersedes all previous policies regarding acceptable use of 
computer resources, facsimile machines, voicemail, email and other 
telecommunications facilities. 

 

The examples of unauthorized use of Spelman electronic resources 
listed above are not meant to be exhaustive. Questions regarding this 
Policy or the application of this Policy to a specific situation should be 
referred to the Vic e President for Media and Information Technology. 
Whenever you are in doubt regarding an issue of questionable use, it is 
in your best interest to resolve the issue before pursing any 
questionable use of electronic resources. 

AC AD E M I C FR E E D O M 

 

The College is committed to academic freedom as stated in the Bylaws 
of the Fac ulty of Spelman College, Article IV: Academic Freedom. The 
assessments of complaints about unauthorized use or misuse of 
electronic resources will be evaluated consistent with this and other 
College policies as listed below. 

 

 
 
 
 
 
 
 
 

APPENDIX C: Green Computing 
 
 

Green Computing 
 

Green c omputing is the practice of finding a balance between work we need to complete, and the work's impact on the environment. There are 
three main considerations in green computing: 

1) the energy the computer system uses 
2) the resources used indirectly when working on the computer (ranging from paper for printing to the 
air conditioning that keeps the machines from over-heating) 
3) what happens to old equipment when it’s replaced or no longer needed 

 

 
 

MIT manages the institutional systems and supports programs with this in mind, but there are steps individual 
users c an take as well. The three quickest and easiest things you can do are: 

Turn off (or hibernate / deep sleep) your computer. Whether you’re away from your room for the day, 
or out of your office for the night, shut down your machine before you leave (or set it to shut down 
automatically). You will not hurt your computer by turning it off and on eac h day. 

Don’t use a screen saver. Instead, have your screen go blank, or better yet actually go to sleep (set via the power management system for 
your computer) - it uses less energy and it’s better for the screen. 

Save paper by printing responsibly. If you have to print, only print the necessary pages. 
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Faculty Self-Service Banner Web 
 
 
 
 

 
TERMS OF USAGE 

 
•  Y ou are entering a secure information area. Unless othe rwise noted, any info rmat ion you ente r or change 

will be effective immediately. Y ou are responsible for any changes made using your ID. Please do not share 

your ID or PIN with ot hers. 
 
 
 

FERPA 
 

 
     For m ore inform ation please visit the Registrar’s Office link on Spelm an’s hom epage. www.spelm an.edu.   

 

 
 

What is FERPA? 
The Fam ily Educational Rights and Privacy Act - also know n as the Buckley Am endm ent (FERPA) (20 U.S.C. 

§ 1232g; 34 CFR Part 99) - is a Federal law that protects the privacy of student education records (i.e. “those 
records, files, docum ents, and other m aterials that …contain inform ation directly related to a student; and are 
m aintained by an educational agency or institution or by any person acting for such agency or institution.” (1:6, 
1998, LRP Publications) FERPA applies to all schools that receive funds under an applicable program of the 
U.S. Departm ent of Education. (1:4, 1998, LRP Publications) It states: No one outside the institution shall have 
access to students’ education records nor w ill the institution disclose any inform ation from those records 
without the w ritten consent of student.  There are e xceptions, such as allow ing certain personnel w ithin the 
institution w ith legitim ate educational interest to view the records, or releasing in an em ergency in order to 
protect the health or safety of students or other persons. 

 
 
 

What is your 
Responsibility 
as a Spelman 
Employee? 

In accordance w ith FERPA regulations, only “…college officials w ho have been determined to have legitim ate 
educational interest in accessing …student records…have a right to re view without student consent.” ( 7:15 , 
1998, LRP Publications) As a Spelman em ployee, your job places you in a position of trust and you play a 
crucial part in ensuring that student inform ation is handled correctly. Students have the right to e xpect that their 
education records are being treated w ith the care and respect that you w ould want for your ow n records. 

The confidentiality, use, and release of these student education records are governed by FERPA. Your use of 
this inform ation is governed by the regulations and the duties and responsibilities of your employm ent and 
position. 
 
In general, all student inform ation m ust be treated as confidential. Even public or "directory inform ation" is 
subject to restriction on an individual basis. Unless your position invol ves release of information and you have 
been trained in that function, any requests for disclosure of inform ation, especially from outside Spelm an, 
should be referred to the Registrar’s Office or the Vice President of Student Affairs.   Inappropriate release of 
inform ation contained on a student's record without the w ritten consent of the person identified on the 
docum ent is in violation of Sec. 438 Public Law 90-247. ( 7:15 , 16, 1998, LRP Publications) 

 
 
 

Other Important 
Things to 
Reme mber 

Picture identification should be checked w hen releasing education records. Also alw ays check to ensure that 
the student permitted disclosure of inform ation before you release any inform ation on the student. 

 
Discussing a student's record with any person w ho does not have a legitim ate education interest is a violation 
of FERPA. This pertains to conversations on and off the job. 
 
Rem oving any student’s education inform ation - in any form - from the office for non-business purposes is a 
violation of FERPA. 
 
Releasing confidential student inform ation (non-directory) to another student, College, organization, or any 
person w ho does not have a legitim ate educational interest, or to the parents of a dependent student w ithout 
the student's w ritten authorization is in violation of FERPA. 

http://www.spelman.edu/
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Leaving reports or com puter screens containing confidential inform ation in view of others w ho do not have a 
legitim ate educational interest in the data or leaving your com puter unattended while connected to Spelm an’s 
netw ork is in violation of FERPA. 

 
Making personal use of student inform ation is in violation of FERPA. 

 
Allowing another person to use your computer access code is in violation of FERPA. 

 
Putting paperw ork in the trash w ith a student's inform ation (i.e. social security num ber or grades) is also in 
violation of FERPA. 

 
In addition to the possibility of personal litigation, proven FERPA violations m ay result in loss of federal funds to 

Spelm an College. 
 

Violation of confidentiality and security m ay lead to appropriate personnel (em ployee or student) action. 
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Faculty Self-Service Banner Web 
 
 
 
 

 
LOGGING INTO BANNER SELF-SERVICE 

 
Go to the MySpelmanPortal  (http://my.spelman.edu). Login and then click on Banner. 

 

 
 
 
 

Once you click on Banner Web a new screen will appear.  Click on Spelman College Self Service Login. 
 

 
 

 

http://my.spelman.edu/
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Faculty Self-Service Banner Web 
 
 
 
 

 
Enter yo ur Spelman College Identification Number (SCID, your 900 #) in the User ID field, and your six 

digit Personal Identification Number (PIN) to login.  This information can be o btained from Human 

Resources. 

 

 
 
 
 

You may be asked to reset your PIN.  Enter your current PIN and then create a new 6 digit PIN.  Click 

Login to continue. 
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Faculty Self-Service Banner Web 
 
 
 
 

 
Next, create a security question and answer and click Submit.  You will have to ans wer this question if 

you forget your PIN. 
 

 
 

 
 
 
 

The Main Menu will appear with a Welcome and yo ur name. 
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PERSONAL INFORM ATION 

 

 
 

Click the Personal Information link to: 

Update addresses, contact information or marital status; review name or social security number change 
information; change yo ur PIN; and custo mi ze your directory profile. 
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FACULTY AND ADVISORS MENU - Faculty Services 
 
 
 

Click on Faculty and Adviso rs link.  Faculty Services menu will appear.  You can 

Enter grades, registration overrides, view class lists and student information. 
 
 
 
 

 

https://banner-web.spelman.edu/pls/prod/twbkwbis.P_GenMenu?name=bmenu.P_FacMainMnu


Media and Infor mation Technolo gy – Banner Ser vi ces 

Page 10 

 

 

Faculty Self-Service Banner Web 
 
 
 
 

 
CLASS ROLL INFORM ATION 

 

 
 

To retrieve class roll information, choose the Term desired. 

 

 
 

 
 
 
 
 

Then choose the year and click Sub mit. 
 

 
 

 
 

 
 
 
 
 

You will be returned to the Faculty Services Menu.  Next, click o n CRN Selection. 

 

 

https://banner-web.spelman.edu/pls/prod/twbkwbis.P_GenMenu?name=bmenu.P_FacMainMnu
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You will see the course(s) that you are assigned for the requested term.  Highlight the desired co urse and 

click Sub mit. 
 

 
 

 
 
 
 
 
 
 
 

 
You will be returned to the Faculty Services Menu.   Now you are ready to choose the information you 

want to view. 
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FACULTY DETAIL SCHEDULE 

 
View course information, enrollment totals and more at a glance. 

 

 
 
 
 

 
WEEK AT A GLANCE 

 
The following is your class schedule by day and time. Classes that do not have scheduled 

meeting times or have time conflicts are listed at the bottom of the page. Click on hyperlinked 

courses for more detail. 
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DETAIL CLASS LIST 

 
View Class and student information. 

** If the word Confidential appears next to a student's name, the personal information is to be kept 

confidential. 

 

 
 

 

SUMM ARY CLASS LIST 

 
Access course information, enrollment count, availability and student information, addresses 

and email addresses when you click on the  stu de nt ’  s  n ame . There is also a link to enter 
Mid- Term Grades and Final Grades. 

 
Click on the envelope next to the student’s name to email the individual or Email the entire 

class from the Email class link at the bottom of the page . 
 

 

https://banner-web.spelman.edu/pls/prod/bwlkfcwl.P_FacClaListSum
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ENTERIN G M ID TERM GR ADES AND FINAL GR ADES 

 

 
 

Enter final grades and last attendance date and hours . If Confidential appears next to a student's name, the 

personal information is to be kept confidential. Click on black arrow to select a grade. If there is a N 
in the Rolled column you can still change the grade from the web process. If there is a Y you must change 

the grade in the Registrar’s Office or electronically via the IBM Notes Dashboard. You can enter one grade 

or multiplegrades. You must click the Submit button below for grades to be updated. 

 

https://banner-web.spelman.edu/pls/prod/bwlkfmgd.P_FacMidGrd
https://banner-web.spelman.edu/pls/prod/bwlkfmgd.P_FacMidGrd


Media and Infor mation Technolo gy – Banner Ser vi ces 

Page 15 

 

 

Faculty Self-Service Banner Web 
 
 
 
 

 
CONFIGURING EM AIL SETTIN GS IN INTERN ET EXPLORER 

 
Open Internet Explorer 

 
Click on Tool s 

Click on Internet Opti ons 

Click on Programs 

Make sure your settings are set as shown below. 

Click appl y. t hen OK. 
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PRINTING YOUR O N-LIN E CL ASS LIST 

 
 Login to Banner Web. 

 Choose Facult y Services. 

 Choose desired term and sub mit. 

 Choose a class li st sel ection (CRN) and Sub mit. 

 Select " Su mmar y Class Li st" (thi s li st i s tabular and past es well into Excel) 

 Draggi ng with the l eft mouse button, sel ect only the table of student infor mation begi nni ng with the title 

Summar y Class Li st and highlight the list until you get to t he botto m. 

 Select "Cop y" from the menu. 

 Open E xcel and sel ect "Paste" from the Edit menu. 

 
Note: Infor mation past ed into Excel may appear co mpressed or abbreviat ed until the colu mns are resi zed. 
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FACULTY AND ADVISORS MENU  - Advisors Services 

 
NOTE:  Advisors must be attached to their advisees in the Banner system in order to view a student’s 

information and to assist with registratio n.  If you have any questions, please see the Registrar’s Office. 
 
 
 
 

STUDENT INFORMATION MENU 
 
 
 
 

TO VIEW: Click on Student Information Menu for more access to more advisors’ tools and additio nal 

student informatio n. 
 

 
 

 

https://banner-web.spelman.edu/pls/prod/twbkwbis.P_GenMenu?name=bmenu.P_FacMainMnu
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Select the Term Selection, enter the student’s ID or name and click Submit.  Now you’re ready to assist 

the student with registratio n, advising or viewing transcripts. 
 

 
 

 
 

GENER AL STUDENT INFORM ATION 
 

This gi ves you t he current program, classi fication and general infor mati on of the student you are assi sti ng. 
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REGISTRATION - ADD OR DROP CLASSES 

 
The student must supply the PIN. 

 

 
 
 
 
 

ADD CL ASSES 
 

Enter the appropriate  Cour se R equest Number s i n t he boxes und er “Add Class” and 

click on t he “Submit Changes” butt on. If you are uncertain of a cour se’ s CRN, 

you may click on the “Class Search” button to find it. 
 
 
 

 

https://banner-web.spelman.edu/pls/prod/bwlkfrad.P_FacAddDropCrse
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CLASS SEARCH 

 

Click on t he Class Search button to start the sear ch. 

 
Use the Class Search option by speci fyi ng the cour se’ s subject. You may narrow the search b y specifyi ng a 

cour se number, title, part of ter m, start ti me, end ti me or days of class meetings. Click on “Find Classes” to 

vi ew t he search r esult s. 
 

 
 
 
 
 

 
 

 
 
 
 
 

The less infor mation you put in for your search, the more i nfor mation you will recei ve i n your r esult s. 
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If a class i s full/closed you will see a  C in the box to your l eft. 
 

 

 
 
 
 

To make a selection click in the box and choose Regi st er. 

• Click  Regist er  - you  are registered in the class. 

• Click Add to  Work Sheet – It i s placed on work sheet, you  must click submit changes to be in the 

class. 
 

 
 

To complete t he web portion of regi stration, click on Sub mit C hanges. 

 
(DO NOT CLICK ON THE BACK ARROW ON YOUR BRO WSER.) 
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VJEW ACADEMIC TRANSCRIPT 

Select  the type  of transcript to v1e 

 

Q Select the transc ript level and transcript  type. 

 

Transcript level: IAll Levels vI 
Transcript Type:  IAdvisor's Copy vI 

 
Display Transcript 

 

 
ELEASE: 8.1 

 
 

Student AcademicTranscript 900000!
 

 
Q This is not an official transcript. Courses which are in progress may also be included on this  transcript. 

 

 
Information for April Test-Student 

Tra nsfer Credit     I nstitution Credit Transcript Totals  Courses in Progress 
 

Transcript Data 

STUDENT INFORMATION 
 

Name : 

student Type: 

Curriculum   nformation 

 
April Test- student 

Cont1numg 

 
Current Program 

College: 

Major and Department: 

Major: 

 

 
Honors Program 

Biochemistry, Chemistry 

Comparati ve Women's 
Studies 

 
***Transcript type:ADVR Advisor's Copy Is NOT Official 

*** DEGREES AWA RDED 

 
 

T RJ\NSFER CREDIT J\CCE (") T ED  BY I NST ITUT IO N  -Top- 

Uni v de Bnhin, Bruzil 

Subjc::".:ct Courc::": Till Gritd c:o: c.-d  i t 
Hour!!i 

 
Qui'tlity  Poi nt  R 

 
C:11 r r..-:ul   T..._ r rr1: 

Atternpt J.Ja!!Ollied l:arned  <.;VA Hour!!i  Quality  <.;J.JA 

Hour-s HOUI"S Hout-s Points 

o_ooo o_ooo o_ooo o _ ooo  o_oo o _oo 

 
Uno ffici al Tr<!lncript 

 
TNST TTIJTT ON C:R FnTT 

 
F,..ll 7004 

C:ollt-":!.jt-o:: 

MaJor: Student   

Iype: J\cadern i c  

Standing: 

 
H t li HH Pt (l iJ i rll ll 

BIOChemi st-ry 

Ne\.v  Hrst I1me 

Subject  Course  Level   Tit : e  Credit 
Hour§ 

Quillity 
Point§ 

Stilrt o:Jnd End  n. 
Date§ 

SAUW 111  uc.; Af nca n U1aspora  & th e WOr1d w  4 .000 u.oo 
Ierrn  Iot,als  (Undergraduate) 

https://banner-web.spelman.edu/pls/prod/bwlkftrn.P_FacDispTran
https://banner-web.spelman.edu/pls/prod/bwlkftrn.P_FacDispTran
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current Terrn: 

<..:urnulative: 

 
J\ttenlpt 
Huur... 

4 .000 

4 .000 

 
.,assed 
Htu 1..-... 

0 .000 

u.uuu 

 
Earned 
Huur... 

0.000 

u.uuu 

 
Gf'J\ Hours  Quality 

Puiul ... 

0.000 

u.uuu 

 

 
0.00 

u.uu 

 
Gl"'l\ 

 

 
0.00 

u.uu 
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